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AEC SOFTWARE, INC. SOFTWARE FASTTRACK SCHEDULE END USER LICENSE AGREEMENT (EULA) 
 
 
NOTE: Refer to the following AEC Software License Agreement and Disclaimer of Warranty and Limited Warranty prior to opening 
the sealed disk or CD package or beginning the installation process. 
 
These license terms are an agreement between you and AEC Software, Inc. (AEC) They apply to the software that accompanies 
these license terms, which includes the media on which you received it, if any.  The terms also apply to any FastTrack Schedule 
updates, supplements and support services for this software, unless other terms accompany those items.  If so, those terms apply. 
  
By installing, copying, or otherwise using the Software, you agree to be bound by the terms of this License Agreement. 
 
All parts of the FastTrack Schedule documentation and software are protected by United States federal copyright law. Copying the 
software for any reason other than to make a backup is a violation of law. Individuals who make unauthorized copies of software 
may be subject to civil and criminal prosecution. AEC Software, Inc. (AEC) licenses certain portions of its software from others 
who require the following disclaimers: 
 
AEC's licensors make no warranties, express or implied, including without limitation the implied warranties of merchantability and 
fitness for a particular purpose, regarding the software. AEC's licensors do not warrant, guarantee or make any representations 
regarding the use or the results of the use of the software in terms of its correctness, accuracy, reliability, currentness or 
otherwise. The entire risk as to the results and performance of the software is assumed by you. The exclusion of implied 
warranties is not permitted by some jurisdictions. The above exclusion may not apply to you.  In no event will AEC's licensors, and 
their directors, officers, employees or agents (collectively AEC's licensors) be liable to you for any consequential, incidental or 
indirect damages (including damages for loss of business profits, business interruption, loss of business information, and the like) 
arising out of the use or inability to use the software even if AEC's licensor has been advised of the possibility of such damages. 
Because some jurisdictions do not allow the exclusion or limitation of liability for consequential or incidental damages, the above 
limitations may not apply to you. AEC's licensors liability to you for actual damages from any cause whatsoever, and regardless of 
the form of the action (whether in contract, tort (including negligence), product liability or otherwise), will be limited to $50. 
 
This is a legal agreement between you (either an individual or an entity), the end user Licensee and AEC Software, Inc. and its 
Licensors (AEC, We or Us), the Licensor. 
 
AS DESCRIBED BELOW, USING THE SOFTWARE ALSO OPERATES AS YOUR CONSENT TO THE TRANSMISSION OF 
CERTAIN COMPUTER INFORMATION DURING ACTIVATION AND VALIDATION. 
 
 
AEC SOFTWARE LICENSE AGREEMENT 
 
1. NOTICE.  
  We are willing to license the enclosed software to you only on the condition that you accept all of the terms 
contained in this license agreement.  
Please read this license agreement carefully before installing the software. By installing, copying, or otherwise using the Software, 
you agree to be bound by the terms of this agreement. If you do not agree to these terms, we are unwilling to license the software 
to you, and you should not open the disk or CD package or install the software. In such case, do not install the software and 
promptly return the unopened disk or CD package and all other material in this package along with proof of payment, to the place 
of purchase or authorized dealer from whom you obtained it for a refund or credit. 
 
 
2. Ownership and License.  
  This is a license agreement and NOT an agreement for sale. We continue to own the software and all other 
copies that you are authorized by this Agreement to make (the Software). Your rights to use the Software are specified in this 
Agreement, and we retain all rights not expressly granted to you in this Agreement. Nothing in this Agreement constitutes a waiver 
of our rights under United States Copyright law, international treaty provisions, or any other federal or state law. IF YOU COMPLY 
WITH THESE LICENSE TERMS, YOU HAVE THE RIGHTS BELOW FOR EACH LICENSE YOU ACQUIRE. 
 
 
3. Permitted Uses.  
  You are granted the following rights to the Software: 
 
 (a) Right to Install and Use.  Use means to access, install, download, copy or otherwise benefit from using the 
functionality of the Software. 
   
  One Platform.  If both the Macintosh and Windows version of the software are included on the CD, then you 
are only licensed to use the Software for one platform (i.e. the Macintosh or Windows version), but not both Platforms. 
   
  Trial and Conversion.  The software may be licensed on a trial basis.  Your rights to use trial software are 
limited to the trial period.  The trial software and length of the trial period are set forth during the activation process, and the trial 
version may contain a subset of the features and functions of the full version.  You may have the option to convert your trial rights 
to perpetual rights.  Conversion options will be presented to you at the expiration of your trial period.  After the expiration of any 
trial period without conversion, most features of the trial software will stop running. After the expiration of your trial period, you are 
legally obligated to discontinue your use of the software and uninstall it.  
   
  Multiplexing.  Hardware or software you use to pool connections or reduce the number of devices or users 



that directly access or use the software (sometimes referred to as "multiplexing" or "pooling") does not reduce the number of 
licenses you need.  The single user version of the software may not be shared, installed or used concurrently on different 
computers.  
   
  Remote Access.  The single primary user of the licensed device may access and use the software installed 
on the licensed device remotely from any other device.  You may allow other users to access the software to provide you with 
support services.  You do not need additional licenses for this access. No other person may use the software under the same 
license at the same time for any other purpose.  
   
  Network Use.  If you have a Concurrent User Version License of the Software, you may install the Software 
on the temporary memory, hard disk drive, or other storage device of a single computer which is accessible by multiple computers, 
such as a network server.  
   
  MANDATORY ACTIVATION. Activation associates the use of the software with a specific device. During 
activation, the software will send information about the software and the device to AEC. This information may include the software 
version, the license version, the language and the product ID of the software, the Internet protocol address of the device and 
information derived from the hardware configuration.  BY USING THE SOFTWARE, YOU CONSENT TO THE TRANSMISSION 
OF THIS INFORMATION AND TO THE STORAGE OF THIS INFORMATION ON SERVERS LOCATED IN THE UNITED 
STATES.  After the time recommended for activation expires, your rights to use the software will be limited until the software is 
activated.  This is to prevent its unlicensed use.  You can activate the software over the Internet.  Internet service charges may 
apply.  Some changes to your computer components or the software may require you to reactivate the software.  THE 
SOFTWARE MAY REMIND YOU TO ACTIVATE UNTIL YOU DO.  
   
  VALIDATION.  The software may from time to time update or require download of the validation feature of 
the software.  Validation verifies that the software has been activated and is properly licensed.  Validation also permits you to use 
certain features of the software or to obtain additional benefits.  During a validation check, the software will send information about 
the software to AEC.  This information includes the version of the software and the product key.  AEC does not use the information 
to identify or contact you.  BY USING THE SOFTWARE, YOU CONSENT TO THE TRANSMISSION OF THIS INFORMATION 
AND TO THE STORAGE OF THIS INFORMATION ON SERVERS LOCATED IN THE UNITED STATES.  If the software is not 
properly licensed, the functionality of the software may be affected.  For example, you may need to reactivate the software, or 
receive reminders to obtain a properly licensed copy of the software, or not obtain certain updates, upgrades or services from 
AEC.  You may only obtain updates or upgrades for the software from AEC or authorized sources.  
   
  INTERNET-BASED SERVICES.  FastTrack Schedule provides Internet-based services with the software, 
such as features in the software can retrieve related content from AEC and provide it to you.  Examples of these features include 
templates, updates and online assistance.  You may choose not to use these Internet-based services.  Except as otherwise noted 
in materials accompanying a service, AEC may change or cancel them at any time.  These Internet-based services connect to 
FastTrack Schedule or service provider computer systems over the Internet.  In some cases, you will not receive a separate notice 
when they connect.  
   
  Single Installation.  You may install and use the Software on the temporary memory or hard disk drive or 
other storage device of any single computer. However, you may not under any circumstances have the Software installed onto the 
temporary memory or hard drives (or other storage devices) of two or more computers at the same time with a single user license. 
If you wish to use the Software on more than one computer, you must either erase the Software from the first hard drive before 
you install it onto a second hard drive, or else license an additional copy of the Software for each additional computer on which 
you want to use it.  
   
  If you acquired a Single User Version License of this Software for business purposes, and installed it on a 
single stand-alone computer, you may, for your convenience, allow the primary user of the Software to also install an additional 
copy of the Software on a second, portable device for the exclusive use of the primary user of the first copy of the Software. so 
long as the Software is not used on both computers at the same time. If the Software will be used on both computers at the same 
time, you must purchase another license.  
   
  If the Software is licensed at an education discount, then the Software may only be used by enrolled 
students, faculty, teachers and administrators at an accredited K-12 educational institution (or equivalent) or higher education 
institution organized and operated exclusively for the purpose of teaching its students. If the Software is licensed at an education 
discount, then it may not be subsequently used for commercial purposes 
   
  Notwithstanding any other terms of this License, to use Software identified as an upgrade, you must first be 
licensed for the software identified by AEC Software as eligible for the upgrade. After installing the upgrade, you may no longer 
use the original software that formed the basis for your upgrade eligibility, except as part of the upgraded software. You agree that 
the upgrade or update does not constitute the granting of a second license to the Software (i.e. you may not use the upgrade or 
update in addition to the software it is replacing, nor may you transfer the software which is being replaced to a third party). 
 
 (b) Right to Copy. You may copy the Software for backup and archival purposes, provided that the original and 
each copy is kept in your possession, and that your installation and use of the Software does not exceed that allowed in part  
(a) above. 
 
 (c) No Right to Transfer. You may not rent, lease, sell or otherwise transfer the software, whether on the 
media, if any, or otherwise, nor any copies of the software, or any of the accompanying documentation. Recipient may not 
disclose, make available, or otherwise redistribute all or any part of the software or any copies thereof to third parties. In addition, 
you may not use the software or any part thereof, in any form, in software or other product that is or will be distributed to a third 
party.  



 
 
4. Prohibited Uses.  
  You may not, without prior written permission from us and paying additional license fees to us:  
 
 (a) Make, use, copy, merge, transfer, sublicense, lend, loan, lease, or rent copies of the Software or 
documentation or any part thereof except as provided in this Agreement; 
 
 (b) Use any backup or archival copies of the Software or documentation or any part thereof (or allow someone 
else to use such copies) for any purpose other than to replace the original copy in the event it is destroyed or becomes defective; 
 
 (c) Disassemble, decompile or unlock, reverse translate, reverse engineer, or in any manner decode the 
Software or documentation or any part thereof for any reason;  
 
 (d) Modify, adapt, translate, or create derivative works of the Software or documentation or any part thereof; 
 
 (e) Deploy or use the Software from an application server, such as Citrix. 
 
 (f) Use a single user license on a network in a server configuration; 
 
 (g) Use multiple single user licenses in conjunction with license metering software, such as Key Server. 
 
 (h)  publish the software for others to copy; 
 
 (i)  use the software in any way that is against the law; 
 
 (j) No other network use is permitted, including but not limited to, using the Software either directly or through 
commands, data or instructions from or to a Computer not part of your internal network, for internet or web hosting services or by 
any user not licensed to use this copy of the Software through a valid license from AEC. 
 
 
5. Limited Warranty.  
  We make the following limited warranties, for a period of thirty (30) days from the date you acquired the 
Software from us or our authorized dealer. This limited Warranty is void if failure of the Software has resulted from accident, 
abuse, or misapplication. Any replacement Software will be warranted for the remainder of the original warranty period or thirty 
(30) days, whichever is longer.  
Neither these remedies nor any product support services offered by AEC are available outside of the United States of America. 
The above warranty applies to the software and not the trial version. 
 
 (a) Media. The disks, or CD, and documentation in this package will be free from defects in materials and 
workmanship under normal use. If the disks or CD or documentation fail to conform to this warranty, you may, as your sole and 
exclusive remedy, obtain a replacement free of charge if you return the defective disk or documentation to us (postage paid) with a 
dated proof of purchase. 
 
 (b) Software. The Software in this package will materially conform to the documentation that accompanies it. If 
the Software fails to operate in accordance with this warranty, you may, as your sole and exclusive remedy, return all of the 
Software and the documentation to the place of purchase or authorized dealer from whom you acquired it, along with a dated 
proof of purchase, specifying the problem, and they will provide you with a new version of the Software or a full refund at their 
election.  
 
 (c) WARRANTY DISCLAIMER. WE DO NOT WARRANT THAT THIS SOFTWARE WILL MEET YOUR 
REQUIREMENTS OR THAT ITS OPERATION WILL BE UNINTERRUPTED OR ERROR-FREE. WE EXCLUDE AND 
EXPRESSLY DISCLAIM ALL EXPRESS AND IMPLIED WARRANTIES NOT STATED HEREIN, INCLUDING THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow the 
exclusion of implied warranties, so the above exclusion may not apply to you. This limited warranty gives you specific legal rights, 
and you may also have other legal rights, which vary from state to state. 
 
 (d) HIGH RISK ACTIVITIES DISCLAIMER. THIS SOFTWARE IS NOT DESIGNED OR INTENDED FOR USE 
OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE 
PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION 
SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE 
FAILURE OF THE SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR 
ENVIRONMENTAL DAMAGE (HIGH RISK ACTIVITIES). AEC SPECIFICALLY DISCLAIMS ANY EXPRESS OR IMPLIED 
WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES. 
 
 
6. LIMITATION OF LIABILITY.   
  AEC, ITS DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS (COLLECTIVELY AEC) LIABILITY TO 
YOU FOR ANY LOSSES SHALL BE LIMITED TO DIRECT DAMAGES FROM ANY CAUSE WHATSOEVER, AND SHALL NOT 
EXCEED THE AMOUNT YOU ORIGINALLY PAID FOR THE SOFTWARE. IN NO EVENT WILL AEC BE LIABLE TO YOU FOR 
ANY CONSEQUENTIAL, INCIDENTAL, INDIRECT, OR SPECIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT 
LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS 
INFORMATION, AND THE LIKE), WHETHER FORESEEABLE OR UNFORESEEABLE, REGARDLESS OF THE BASIS OF THE 



CLAIM AND EVEN IF WE HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  
Some jurisdictions do not allow these limitations or exclusions, so they may not apply to you. 
 
 
7. United States Government Restricted Rights.  
  This software and documentation is commercial computer software under the Federal Acquisition Regulation 
and agency supplements to it (FAR). This software and documentation are provided to the Federal Government and its agencies 
only under the restricted rights provision of the FAR applicable to commercial computer software developed at private expense 
and not in the public domain. Use, duplication or disclosure by the U.S. Government or any agency or instrumentality thereof is 
subject to restrictions as set forth in subdivision (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DEARS 
252.227-7013, or in FAR 52.227-19, or in FAR 52.227-14, as applicable and as set forth in this license to the extent that the 
restrictions in this license are not inconsistent with the Government's minimum rights in restricted rights software. Contractor / 
Manufacturer is AEC Software, Inc., 22611 Markey Court, Building 113, Sterling, Virginia 20166 U.S.A. 
 
 
8. Export Controls.  
  You agree that you will not directly or indirectly transfer the Software or documentation to any country to 
which such transfer would be prohibited by the United States Export Administration Act and the regulations issued thereunder.  
 
 
9. TERMINATION.   
  Without prejudice to any other rights, AEC Software may terminate this EULA if you fail to comply with the 
terms and conditions of this EULA. In such event, you must destroy all copies of the Software and all of its component parts. 
 
 
10. Illegal Use of the Software:   
  If you are found to be using pirated software or found to be using the Software in contravention to this EULA 
you will be prosecuted to the full extent of the law. 
 
 
11. Miscellaneous Provisions.  
  This Agreement will be governed by and construed in accordance with the substantive laws of the 
Commonwealth of Virginia, U.S.A. This is the entire agreement between us relating to the contents of this package, and 
supersedes any prior purchase order, communications, advertising or representations concerning the contents of this package. No 
change or modification of this Agreement will be valid unless it is in writing, and is signed by us. 
 
Canadian Transactions:  
If you acquired this Software in Canada, you agree to the following:  
The parties hereto have expressly required that the present Agreement and its Exhibits be drawn up in the English language.  
Les parties saisissants ce produit ci-joint ont exigé que l'accord actuel et ses objets exprimés soient élaborés en langue anglaise. 
 
Other International Transactions:  
If you acquired this Software outside the U.S.A. or for use outside the U.S.A. you agree to the following: The parties hereto have 
expressly required that the present Agreement and its Exhibits be drawn up in the English language. 
 
If you have any questions about this Agreement, write to AEC Software Inc., 22611-113 Markey Court, Sterling, Virginia 20166 
U.S.A. or call at +1 (703) 450-1980. 
 
FastTrack Schedule(TM) is a trademark of AEC Software, Inc. 
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Chapter 1: Welcome to FastTrack Schedule 

About this guide 
This guide is written for the network administrator who will be installing FastTrack 
Schedule on a network. This guide provides instructions for installing FastTrack 
Schedule on a network server and information relevant to running FastTrack Schedule 
over a network. 
 
♦ Chapter 1, Welcome to FastTrack Schedule, describes the minimum 

requirements for running the application, how to register the application, and 
provides details on AEC Software Support Services. 

♦ Chapter 2, Installing FastTrack Schedule, provides instructions for installing the 
application on a network server, entering the license key, adding licenses for 
concurrent users, and creating aliases and shortcuts on individual workstations. 

♦ Chapter 3, Additional Installation Activities, describes the following installation 
activities: setting user access privileges and defining templates. 

♦ Chapter 4, Using FastTrack Schedule Over a Network, describes issues and 
situations that may arise when running FastTrack Schedule over a network. This 
chapter includes general issues, as well as platform-specific issues. 

 
The License Log, which appears on the back cover of this guide, provides an easy 
and accessible way to keep track of your FastTrack Schedule licenses.  
 
All FastTrack Schedule documentation assumes that you are familiar with using your 
computer, operating system, and printer. You should also be familiar with the typical 
operation of applications on Windows or Mac operating systems. This includes 
common operations like dragging using a mouse and cutting, copying, and pasting 
text. If you have any questions, refer to the documentation that describes your 
operating system and these common operations. 
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Hardware and software requirements 
The following hardware and software is required to run FastTrack Schedule: 
 
To run FastTrack Schedule on a Microsoft Windows® operating system, you 
need: 
♦ A computer properly configured and running Microsoft Windows 7, Windows Vista, 

Windows XP. 
♦ 512 MB or more of random access memory (RAM) 
♦ 150 MB or more of available hard disk space 
♦ A CD-ROM drive or Internet access 
♦ A color monitor with 1024 x 768 resolution or greater 
 
To run FastTrack Schedule on a Mac® computer, you need: 
♦ A computer properly configured and running Mac OS X version 10.5.8 or greater 
♦ 512 MB or more of random access memory (RAM) 
♦ 150 MB or more of available hard disk space 
♦ A CD-ROM drive or Internet access 
♦ A color monitor with 1024 x 768 resolution or greater 

Registering your application 
It is extremely important that you register your application online as soon as possible. 
This is the only way we can provide you with the customer support that you deserve. 
When you register your application, we make available these valuable services: 
 
♦ Technical support  
♦ Customer support 
♦ Notices of upgrades and changes via email 
♦ Free updates 
 
 
Or you can register online at: http://www.aecsoftware.com/support/register/ 
Please take a minute now to register your application  and read the following 
information about customer and technical support. Our privacy statement is available 
online. 

AEC Software support services 
If you have a question about the operation of the application, first look in the Online 
Help system or in this manual. If you cannot find the answer to your question, contact 
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AEC Software Technical Support. Technical Support is typically available Monday 
through Friday, between 8:00 AM and 5:00 PM Eastern Standard Time, USA. 
 
You can contact AEC Software Technical Support in a variety of ways: 
 
♦ Phone: (703) 450-2318 
♦ Fax: (703) 450-9786 
♦ Email: support@aecsoftware.com 
♦ WWW: http://www.aecsoftware.com/support 
 
For sales information, (703) 450-1980. 
 
When you call AEC Software Technical Support, your computer and FastTrack 
Schedule should be running and you should be in front of your computer. 
 
Please be prepared to provide the following information: 
 
♦ Your license key. (This number is found on the CD sleeve, or in the purchase 

confirmation email.) 
♦ The product version number. 
♦ The type of hardware and the operating system on which you are running the 

application. 
♦ The exact nature of your problem and what you were doing when it occurred. 
♦ The exact message in any alerts or dialog boxes that appear on your screen in 

response to your problem. 
♦ Any and all steps you have taken to solve the problem. 
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Chapter 2: Installing FastTrack Schedule 

The primary activities involved in installing the concurrent user version of FastTrack 
Schedule are: 
 
♦ Removing earlier versions of FastTrack Schedule software (if you are upgrading) 
♦ Installing the latest FastTrack Schedule software 
♦ Entering your license key 
♦ Adding licenses for concurrent users 
♦ Setting up quick access to FastTrack Schedule on individual workstations 
 
If you have an earlier version of FastTrack Schedule installed on your network, begin 
with the section, Upgrading from an earlier version of FastTrack Schedule. If you do 
not have an earlier version of FastTrack Schedule installed on your network, begin 
with the section, Installing the concurrent user version of FastTrack Schedule. 
 
After completing the installation activities described in this chapter, see Chapter 3, 
Additional Installation Activities for instructions on how to perform the following final 
installation activities: 
 
♦ Setting user access privileges 
♦ Redefining the factory default schedule 

Upgrading from an earlier version of FastTrack Schedule 

Removing previous versions 
If you are upgrading FastTrack Schedule from an earlier version, the FastTrack 
Schedule Installer will not automatically delete the older version. You MUST delete the 
older version of FastTrack Schedule. The license for the older version is void once 
you install a new version. 
 
Important: 
Before you delete the older version of FastTrack Schedule, move or copy all your 
FastTrack Schedule data files to a folder other than the FastTrack Schedule folder. 
Once you delete a file, it may not be possible to restore the file. Consult your 
operating system documentation for more information about deleting, copying, and 
restoring files. 
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Removing a previous version from a Mac network 
To remove an earlier version of FastTrack Schedule, you must delete the FastTrack 
Schedule folder and all its subfolders from the network server, and then delete 
FastTrack Schedule aliases from individual workstations.  
 
To remove a previous version of FastTrack Schedule from a Mac network: 
1. On the network server, find the folder that contains the previous version of 

FastTrack Schedule. 
This folder should contain the FastTrack Schedule application, as well as the 
Help, Examples, Templates, and Tutorial folders. If you are removing FastTrack 
Schedule 4.0x, 5.0x, 6.0x, 7.0x, or 8.0x, this folder will also contain the AppData 
folder. 

2. Move any templates you wish to save to another folder. 
3. Select the folder, and then drag it to the Trash. 
4. On each workstation, find the FastTrack Schedule alias. 
5. Select the alias, and then drag it to the Trash. 
 

Removing a previous version from a Windows network 
To remove an earlier version of FastTrack Schedule, you must delete the FastTrack 
Schedule directory and all its subdirectories from the network server and then delete 
FastTrack Schedule shortcuts and program groups from individual workstations. If you 
wish to save your templates, copy them to a different folder before deleting. 
 
The method for deleting the FastTrack Schedule directories and subdirectories 
depends on which version of FastTrack Schedule is installed. This guide describes the 
methods for removing versions 4.0x, 5.0x, 6.0x, 7.0x, or 8.0x. Contact AEC Software 
Technical Support for instructions on removing earlier versions of FastTrack 
Schedule. 
 

Removing FastTrack Schedule version 4.0x, 5.0x, 6.0x, 7.0x, 8.0x, or 9.0x 
from a network with a Microsoft, Windows XP, Windows Vista, Windows 7,  
Windows 2003 server, or Windows 2008 server 

To remove a previous version from the server: 
1. From your console, click the Start button. 
2. From the Start menu, select Settings, and chose Control Panel. 
3. Double-click Add/Remove Programs. 
4. If it is not already selected, click the Install/Uninstall tab. 
5. Select FastTrack Schedule from the list of installed applications. 
6. Follow the instructions displayed on the screen. 



Chapter 2:  Installing FastTrack Schedule 

12 

7. On each workstation, find the FastTrack Schedule shortcut icon. 
8. Select the icon, and then press the Delete key. 
 
Note: 
Remember that the directions above must be performed on the network server—not 
just a remote computer. 

Installing the concurrent user version of FastTrack Schedule 

Installing the Windows concurrent user version 
Installing FastTrack Schedule on a Windows network is similar to installing to a local 
drive. You first prepare the network for installation, and then install the software on the 
server. After installing FastTrack Schedule on the server, you create shortcuts on the 
individual workstations used by the end users.  
 

Preparing the network 
 
To prepare the network for installation: 
1. Login as the System Administrator (or its equivalent) for your network. 
2. Connect to the destination server and shared directory where you wish to install 

FastTrack Schedule. 
If you are installing on a Windows server that is running NTFS file system, you 
need to set Share level permissions as well as File level permissions. 

3. Continue to the next subsection, “Installing FastTrack Schedule on a Windows 
server.” 

 

Installing FastTrack Schedule on a Windows server  
It is best to install the software directly at the server. Installing from a remote 
workstation will require additional steps. 
 
To install FastTrack Schedule on a Windows server: 
1. Exit all currently running applications and disable virus protection software. 
2. Insert the FastTrack Schedule CD-ROM into the CD-ROM drive. 
3. Wait for a dialog to automatically appear. 
4. Click the Install button. 
5. Read the license agreement and click Yes to accept it. 
6. Read the contents of the ReadMe file, and then click Next. 
7. In the Location Installation screen, click Browse to navigate to the location on 

the server to which you want to install FastTrack Schedule. 
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8. Follow the instructions displayed on the screen to select the location. 
9. Click Next. 
10. In the Setup Type screen, select the installation type. 
11. Click Next. 
12. Select your Shortcut options. 
13. Click Next. 
14. In the Select Program Folder screen, if you want to, change the default name of 

the FastTrack Schedule program folder by typing a new name or selecting one 
from the existing list. 

15. Click Next. 
16. If you have already read the ReadMe file, deselect the Yes, I would like to read 

the ReadMe file now option. 
17. If it is not already selected, select the Yes, I would like to run FastTrack 

Schedule now option. 
18. Click Finish to launch FastTrack Schedule. 
19. Continue to the section, Entering your license key. 
 

Installing the Mac concurrent user version 
Installing FastTrack Schedule on a Mac network is similar to installing it on a local 
drive. You first prepare for network installation, and then install the software on the 
server. After installing FastTrack Schedule on the server, you then create aliases to 
FastTrack Schedule on the individual workstations used by the end users. Instructions 
for creating aliases appear later in this chapter. 

 
 
To install FastTrack Schedule on a Mac server: 
1. Disable virus protection software. 
2. Login as the System Administrator (or its equivalent) for your network. 
3. Connect to the destination server and shared folder where you want to install 

FastTrack Schedule. 
4. Insert the FastTrack Schedule CD into the CD-ROM drive. 
5. Double-click the Start Here icon. 
6. Click the Click to Install FastTrack Schedule 10 button to run the installer. 
7. Read the ReadMe file. 
8. Click Continue. 
9. Read the license agreement, click Continue and select Agree to continue. 
10. Click the Select Folder button and navigate to the location on the server where 

you want to install FastTrack Schedule. 
11. Click Choose. 
12. Click Continue. 
13. Select the installation type and follow the instructions displayed on the screen. 
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14. When the alert appears saying the application was successfully installed, click 
Quit, to quit the installer. 

15. Continue to the next section, Entering your license key. 

Entering your license key 
When you start the application for the first time, the Registration dialog opens. Enter 
your name, organization, and your application’s license key in this dialog. You can find 
your license key in the purchase confirmation email, or on the CD container. 
 
To enter your license key for FastTrack Schedule: 
1. If FastTrack Schedule is not already running, start the application. 
2. Enter your name, organization, and your application’s license key. 
3. Click OK to close the Registration dialog. 

Your registered copy of FastTrack Schedule opens. 
4. To close the application: 

On Windows: From the File menu, choose Exit. 
On Mac OS X: From the FastTrack Schedule menu, choose Quit FastTrack 
Schedule. 

5. Continue to the next section, Adding licenses for concurrent users. 

Adding licenses for concurrent users 
The term concurrent users is defined as more than one person accessing, at the same 
time, a single copy of FastTrack Schedule stored on a network server. Your 
concurrent user version of FastTrack Schedule has a license key that controls the 
maximum number of concurrent users.  
 
When you initially install FastTrack Schedule, the default number of concurrent users 
is one. To enable more than one user to concurrently use FastTrack Schedule, you 
need to enter a valid Concurrent User License Key. This number is found in the 
purchase confirmation email, and on the envelope containing the CD-ROM. 
To configure your copy of FastTrack Schedule for concurrent users: 
1. Make sure that FastTrack Schedule has been installed on a server or shared 

directory. 
2. If it is not already running, start FastTrack Schedule from a workstation. 
3. To open the About dialog: 

On Windows: From the Help menu, choose About. 
On Mac OS X: From the FastTrack Schedule menu, choose About FastTrack 
Schedule. 

4. Click the Change License button. 
The Enter License dialog opens. 
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5. Enter your license Key in the License Key box.  
6. Click OK to close the Enter License dialog. 
7. Click OK to close the About FastTrack Schedule dialog. 
8.   To close the application: 

On Windows: From the File menu, choose Exit. 
On Mac OS X: From the FastTrack Schedule menu, choose Quit FastTrack 
Schedule. 

 
 

Note:  
Adding more concurrent users to your license is an easy task. If you wish to purchase 
additional licenses to increase the number of licensed concurrent users, call the AEC 
Software Corporate Sales Department at (800) 450-1985 or (703) 450-1980, or send 
an email to sales@aecsoftware.com. When ordering, you will need to verify your 
license key. This number is found in the purchase confirmation email or on the 
envelope containing the CD-ROM.  
 
Upon purchasing additional licenses for concurrent users, you will receive a new  
purchase confirmation email with a new license key. 
 
Important: 
The license key for the previous number of licenses is VOID once you install the new 
license key. You must delete or cover all references to the prior license key from the  
CD cover, and your registration information. 
 
10. Continue to the next section, Setting up quick access for the end user. 

Setting up quick access for the end user 
Once you have installed FastTrack Schedule on the network server, you can create 
an alias or shortcut for FastTrack Schedule on the end user’s workstation. The end 
user will then be able to run FastTrack Schedule without manually navigating to the 
server each time. 
 

Creating a shortcut on a Windows XP, Windows Vista, Windows 7  

To create a shortcut on a Windows workstation: 
1. From a Windows workstation, login as an end user. 
2. Create shortcuts to the application on each user’s workstation. 
3. Continue to the subsection “Setting user access privileges” in Chapter 3, 

Additional Installation Activities. 
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Creating an alias on a Mac workstation 
To create an alias on a Mac workstation: 
1. From a Mac workstation, login to the server as an end user. 
2. From the Mac workstation, navigate to the FastTrack Schedule application on the 

server. 
3. Press the Control key and click on the FastTrack Schedule 10 icon. 
4. From the Context Menu select Make Alias. 

The Alias will appear. 
5. Drag the Alias to the user’s desktop or to the user’s dock. 
6. Repeat Steps 1 through 5 for each Mac workstation. 
7. Continue to the subsection “Setting user access privileges” in Chapter 3.
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Chapter 3: Additional Installation Activities 

This chapter describes the following installation activities: 
 
♦ Setting user access privileges 
♦ Defining factory and default schedules 
♦ Defining templates 

Setting user access privileges 
In general, application access privileges are granted automatically to any user who 
has rights to access the folder that contains the FastTrack Schedule application and 
view the folder from their individual workstation. To ensure that appropriate access is 
granted, make sure the following access rights are designated. 
 

Setting user access privileges for Windows users 
To set user access privileges for Windows users: 
1. Designate the following application and directory as shareable: 

FastTrack Schedule directory and application (FSch.exe)  
2. Give users read/write privileges to the AppData directory and its contents in the 

FastTrack Schedule directory on the server. 
If you are installing on a Windows server that is running NTFS file system, you 
need to set Share level permissions as well as File level permissions. Share level 
permissions are accessed in the “Sharing” tab by clicking the “Permissions” 
button. File level permissions are accessed in the “Security” tab.   

 
Users need only read-only privileges for all other FastTrack Schedule files and 
directories, including the application itself, Template files/directory, Example 
files/directory, Help files/directory, and Tutorial files/directory. See your network 
documentation for specific instructions on how to set access privileges.  
 

Setting user access privileges for Mac users 
On Mac OS installations of FastTrack Schedule, the FastTrack Schedule application is 
built into a package. A package functions as a folder that Mac OS X treats like a 
simple application. Although Mac packages are “seen” as one file, they are treated like 
a folder on the file system level and carry the same access privileges as any other 
folder. 
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To set user access privileges for Mac users: 
1. Designate the following applications and folders as read-only access 

FastTrack Schedule 10 application and enclosing folder 
2. Give users read/write privileges to the AppData folder and its contents inside the 

FastTrack Schedule application/package on the server using the following steps. 
3. Control-click on the FastTrack Schedule 10 application icon and select Show 

Package Contents from the pop-up menu. 
This opens the package as a folder. 

4. Locate the subfolder using the following path: 
FastTrack Schedule.app:Contents:MacOS:AppData 

5. Control-click the folder and select Get Info. 
6. Make sure that the folder privileges are set to allow read/write access. 

Defining factory and default schedules 
The installation of FastTrack Schedule includes a file named FSch.dft, which is 
located in the AppData folder beside the application on the server. This file is the AEC 
Software-provided “factory schedule.” 
 
The first time an end user selects New from the File menu, and then selects New 
Blank Document the factory schedule opens. Once it has been opened in this way, the 
factory schedule is saved as that workstation user’s default schedule.  
 
The workstation’s “default schedule”, also named FSch.dft, can be found in the 
FastTrack Schedule 10 folder within the AEC Software folder at the following local 
locations: 
 
♦ The workstation’s user roaming settings (for Windows Vista and 7) 
♦ The workstation’s user documents and settings (for Windows XP) 
♦ users/username/Library/Preferences/AEC Software/ FastTrack Schedule 10 (on 

Mac OS X) 
 

Important: 
The local locations listed above will be referenced repeatedly in this chapter. 
 
Once a workstation’s FSch.dft file has been created, FastTrack Schedule will use it to 
open a new blank schedule.  
 
A default schedule contains the following schedule elements: 
 
♦ Custom bar styles 
♦ Custom filters 



Chapter 3: Additional Installation Activities  

19 

♦ Custom ranges 
♦ Custom sorts 
♦ Custom layouts 
♦ FastSteps scripts 
♦ Default timescale rows 
♦ Values for the Format Schedule View dialog (including values for the timeline start 

and finish dates, base timeline units, dateline, and Work Calendar) 
♦ Values for the Format Resources View dialog (including values for the timeline 

start and finish dates, base timeline units, dateline, and Resource Allocation Units) 
♦ Values for the Format Calendar View dialog (including values for the range start 

and finish dates) 
 
The default schedule also contains the following formatting information: 
 
♦ Default size and position of the schedule window (if not zoomed to maximum 

position) 
♦ Default column formatting 
♦ Default row formats (row height and summarization) 
♦ Default font settings 
♦ Default graphic item formats 
♦ Default import and export settings 
♦ Headers and footers 
♦ Default printer information 
♦ Default page options 
♦ Default font attributes 
 
A default schedule makes it easy for end users to get a quick start when creating a 
new schedule. They will not need to define commonly used elements and settings. For 
example, if users always use a particular column displayed in the schedule, it can be 
included in the default schedule. 
 

Customizing the factory schedule: overview 
This section provides an overview of the process of customizing the factory schedule. 
The actual steps for customization are described in the next subsection, “Creating a 
custom factory schedule.” 
 
When FastTrack Schedule is installed, it includes a factory schedule —it is stored in 
the file named FSch.dft, located in the AppData folder beside the application on the 
server. This schedule is referred to as the AEC Software-provided “factory schedule.” 
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As a network administrator, you may be responsible for customizing the AEC 
Software-provided factory schedule to one that is tailored to the needs of your 
company. For example, your company may always want to include custom columns or 
custom sorts and filters. By redefining the AEC Software-provided factory schedule, 
you can create a custom schedule that will become the default schedule on each 
workstation. 
 
You begin by creating a schedule that has the settings that you want. These settings 
were described in the previous section. After defining the schedule, you can save its 
settings by selecting Capture Current from the Options> Application>General dialog 
(on Windows) or Preferences>Application>General dialog (on Mac). 
 
After saving the schedule, you need to make it accessible to the users on your 
network. Copying the FSch.dft file, in the FastTrack Schedule 10 folder in the AEC 
Software folder found on the local workstation, to the AppData folder located on the 
server replaces the factory schedule provided by AEC Software with your custom 
default schedule. 
 
When FastTrack Schedule is accessed from a workstation for the first time, the file 
FSch.dft in the AppData folder is automatically copied to the workstation location. 
 
Important: 
You should avoid deleting the AEC Software-provided factory schedule, which is 
located beside the application in the AppData folder on the server. The factory 
schedule provides a useful framework for creating a new schedule. You can back the 
factory file up and replace it, but if it does get deleted and there is no backup, simply 
reinstall the application and it will be restored.  
 
Notes:  
♦ This installation procedure is optional. You can redefine the AEC-provided factory 

default schedule at any time. However, if you perform it at a later point in time, you 
will need to make sure that the revised version of the file FSch.dft is distributed to 
the end-user workstations. The first time FastTrack Schedule is run on the 
workstation, a copy of the FSch.dft file is created on the workstation but a revised 
version on the server is not automatically copied to the workstation. 

♦ If you plan on opening or importing MindManager MindMap files, you may also 
wish to customize the fschmmap.dft file. When you open a mmap file, this default 
file is used instead of the FSch.dft file. It can be edited in the same manner as the 
factory default schedule. 

♦ If you plan on importing schedules from MS Project in xml format, you may also 
wish to customize the fschxml.dft file. When you open an xml file, this default file 
is used instead of the FSch.dft file. It can be edited in the same manner as the 
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factory default schedule. 
♦ If you plan on importing schedules from MS Project in mpx format, you may also 

wish to customize the fschmpx.dft file. When you open an mpx file, this default file 
is used instead of the FSch.dft file. It can be edited in the same manner as the 
factory default schedule. 

 
The procedure that is described in the following section assumes that you are 
redefining the factory default schedule before any end users have used the newly 
installed copy of FastTrack Schedule. 

Creating a custom factory schedule 
The following figure shows the configuration of a network just after FastTrack 
Schedule was installed on the server. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
Perform the following steps to create a custom factory default schedule that is copied 
to the server and then to the end-user workstations. 
 
To define a custom factory default schedule: 
1. Start FastTrack Schedule from the network administrator’s workstation. 
2. From the File menu, select New. 

The New File dialog opens. 
3. Select New Blank Document. 
4. Click OK to create the new document and close the New File dialog. 
5. Create a schedule with the desired default settings. 
6. Access the schedule default options: 

Server

         Local location 
 

              Local location 

Network administrator’s 
workstation End-user workstation 

AppData folder  
Factory File – FSch.dft 

Location of AEC 
Software-provided 
factory schedule 
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On Windows: From the Tools menu, select Options then choose Application to 
open the FastTrack Schedule Options dialog. 
On Mac OS X: From the FastTrack Schedule menu, select Preferences, then 
choose Application to open the FastTrack Schedule Preferences dialog. 

7. In the General tab, select Capture Current from the New Schedule Defaults 
area. 

8. Click OK to capture the schedule and close the dialog. 
The user’s local location on the network administrator’s workstation now contains 
an AEC Software folder. The default file, FSch.dft, in the FastTrack Schedule 10 
folder contains the new custom settings you just created. The following figure 
illustrates the resulting network configuration. 
 

 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
9.   To close the application: 

On Windows: From the File menu, choose Exit. 
On Mac OS X: From the FastTrack Schedule menu, choose Quit FastTrack 
Schedule. 
 

10. Copy the FSch.dft file from the local location on the network administrator’s 
workstation to the AppData folder in the FastTrack Schedule folder on the 
server. This alters the factory schedule so that its settings are now those of the 
network administrator’s customized default schedule. 

Server

AppData folder  
Factory File – FSch.dft

Network administrator’s 
workstation End-user workstation 

Location location 
Default File – FSch.dft 

Local location 

Location of AEC 
Software-provided factory 
schedule 

Network Administrator’s  
Default File just created 
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The following figure illustrates the resulting network configuration. 
 
 
 
 
 
 
 
 

 
 

 
 
 
 

 
11. Start FastTrack Schedule from each of the end-user workstations. 

 
When FastTrack Schedule is run for the first time on an end-user workstation, the 
AEC Software/FastTrack Schedule 10 folder/directory is created in the user’s local 
location, and the factory file, FSch.dft, is automatically copied from the server to the 
newly-created FastTrack Schedule 10 folder, thus becoming that workstation’s default 
file. The following figure illustrates the resulting network configuration. 
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Default File – FSch.dft 

Network administrator’s 
workstation 

Manually copy the 
Network  
Administrator’s  
Default File –FSch.dft  
over top of the Server Factory  
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Restoring the custom default schedule settings 
An end user can redefine the default schedule on a workstation by opening a 
schedule, altering it, opening the FastTrack Options dialog (on Windows) or the 
FastTrack Preferences dialog (on Mac), and choosing Capture Current. The settings 
of the opened schedule are saved as the settings of the default schedule; the FSch.dft 
file in the local location on the workstation is updated with the new settings. 
 
If a specific end user wants to restore the default schedule’s settings to those of the 
factory schedule, they should perform the following steps on their workstation. 
 
To restore the custom default schedule: 
1. Access the schedule default options: 

On Windows: From the Tools menu, select Options then choose Application to 
open the FastTrack Schedule Options dialog. 
On Mac OS X: From the FastTrack Schedule menu, select Preferences, then 

AppData folder  
Factory File – FSch.dft 

Network administrator’s 
workstation 

End-user workstation 

Local location 
Default File – FSch.dft

Local location 
Default File – FSch.dft 

Server 

The Factory File – FSch.dft is copied 
automatically to become this workstation’s 

default file 
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choose Application to open the FastTrack Schedule Preferences dialog. 
2. In the General tab, select Restore to Factory from the New Schedule Defaults 

area. 
3. Click OK to restore the schedule and close the dialog. 

The factory file, FSch.dft, located in the AppData folder on the server is copied to 
the AEC Software folder on the end-user workstation. 

4. Repeat Steps 1-3 for all workstations that need the custom factory schedule’s 
settings restored as their default. 

Defining templates 
In addition to default schedules, FastTrack Schedule users can also use templates to 
create new schedules. A template is very similar to a default schedule. Like a default 
schedule, a template can contain schedule elements and formatting; but in addition, it 
can also contain schedule data such as activity names, activity dates, and data from 
other columns. Templates are useful when many projects involve essentially the same 
activities. Including these activities in a template means that users do not have to 
redefine or transfer the activities each time they create a new schedule. 
 
To create a new schedule using a template, an end user first chooses New from the 
File menu. In the New File dialog, the user clicks the Template tab. The user can 
select from the categories of available templates or click the Browse button to 
navigate to a template saved in another location.  The Templates tab contains a list of 
existing templates that the user can choose from. This list contains templates that are 
stored on both the server and individual workstations. Only those templates stored on 
the server are accessible to all users on the network.  
 
Templates stored on the server are located in the Templates subfolder/subdirectory 
that is in the same folder as the FastTrack Schedule application. To locate templates 
stored on individual workstations navigate to the “AEC Software/FastTrack Schedule 
10” folder at the local location. Open the AppData, AEC Software, and FastTrack 
Schedule 10 folders. The Templates subfolder/subdirectory is stored in the FastTrack 
Schedule 10 folder.  
 
In FastTrack Schedule 10, all files saved in your local or network Templates 
subfolder/subdirectory appear in the Templates tab of the New File dialog. If you 
create a folder in the Templates subfolder/subdirectory, this will appear as a category 
in the Templates tab. This allows you to organize your templates by creating whatever 
categories you choose and moving your schedules between them. 
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Chapter 4: Using FastTrack Schedule Over a Network 

The concurrent user version of FastTrack Schedule provides seamless integration of 
files between local workstations and the server. This chapter contains information 
about concurrent usage, file locking, fonts, and cross-platform issues that network 
administrators should be familiar with. It also contains information about online help, 
troubleshooting, and frequently asked questions. 
 

Concurrent usage 

Exceeding the number of licensed concurrent users 
When a user launches FastTrack Schedule and the number of current users exceeds 
the number permitted by the concurrent-user license, FastTrack Schedule displays a 
dialog. When the user clicks “Conflicts”, a dialog appears listing the user names 
currently running that licensed version of the application. 
When the user clicks “OK”, a dialog appears that allows him to save open files.  
 

Read/write and read-only access 
FastTrack Schedule allows only one user at a time to open a file and make changes to 
it as a read/write file. Subsequent users attempting to concurrently open that file will 
only be able to open the file as a read-only file until the first user closes the file. 
 
If you open a file with read-only privileges, and the file later becomes available with 
read/write access privileges while you are still working within the application, you must 
reopen the file to gain read/write access privileges. You will not be able to save the file 
using Save, but you can save the file under another name by selecting Save As from 
the File menu. 
 
To open a file on the network: 
1. Open the file. 
♦ If the file is not currently in use with read/write access privileges by another user, 

use the file the same way you would use other files. 
♦ If the file is currently in use with read/write access privileges by another user, a 

warning will appear. This warning is a function of your network. 
2. To save a new copy of a file opened with read-only access privileges, select Save 

As from the File menu.  
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None of the changes made to a read-only file will be saved at this time. The file is 
saved as an exact replica of the read-only file, but once the user that opened the file 
closes it, the user can then open it again with read/write access.  
 
To re-establish read/write privileges after a file has been closed: 
1. If you have a file with read-only access open, close the file. 
2. Reopen the file to establish read/write privileges. 
 
You now have read/write privileges. Any other users that try to open the file will be 
warned that they may only open the file as read-only. 

Apple File Protocol permission model 
The Apple File Protocol (AFP) permission model is a Mac networking protocol that 
allows a FastTrack Schedule file with read-only privileges to be opened multiple times 
across a Mac network. Without the AFP permission model, only one user at a time 
can open the file. If your network does not use the AFP permission model, you will not 
be able to open a file multiple times. This technology only affects whether or not a file 
can be opened multiple times and does not impact the performance of FastTrack 
Schedule. 
 
Note:  
Most current network operating systems comply with the Apple File Protocol 
permission model, but some older systems may not. 

Fonts 
If a file is opened on a workstation that has different fonts than the workstation it was 
created on, font substitution may occur, causing text in columns, headers, and footers 
to wrap differently. Use fonts that are common to both workstations to prevent font 
substitution. 

Using files across platforms 
You can create a schedule using either the Mac or Windows versions of FastTrack 
Schedule and effortlessly use it between the two platforms. To convert a schedule, 
simply open the schedule on the other platform; FastTrack Schedule automatically 
converts the file. This flexibility provides you with the most dynamic cross-platform 
project scheduling solution. There are, however, some issues related to converting 
schedules of which you should be aware. 
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Printer information 
The page orientation, page size, and percent of enlargement or reduction set for a file 
on one platform is not transferred to the other platform. These settings are 
independent of FastTrack Schedule and are stored uniquely for printers on each of the 
platforms on which the schedules are saved. 
 
The default printer settings for the platform on which a schedule file is converted 
determines the settings used. If the page orientation, page size, or percent 
enlargement or reduction needs to be changed, select Page Setup from the File menu 
to set the printer setting to the desired values. 

Using online help 
Online help is available to all concurrent users provided that the Help folder is 
designated as sharable and is in the location where the FastTrack Schedule 
application was installed. 
 

Restarting after unexpected termination 
FastTrack Schedule keeps track of which users are concurrently using the licensed 
copy of the application. If the application should terminate unexpectedly (for example, 
a power failure or system error), this information could be inconsistent with the actual 
number of concurrent users. FastTrack Schedule automatically cleans up damaged 
information after an unexpected termination; however, the application must be running 
to do so.  
 
To facilitate a faster clean-up of the unexpected termination: 
 
1. Restart FastTrack Schedule from any workstation that was running FastTrack 

Schedule and experienced an unexpected termination. 
 

The application can be used by this workstation or any other workstation during 
this time; clean-up occurs in the background. If you cannot run the application 
because the Concurrent Users dialog appears, then try Step 2. 

 
2. If you do not know which workstation(s) were running FastTrack Schedule when 

the unexpected termination occurred, run the application from any workstation for 
approximately 15 minutes (time will vary based on the number of users and 
network traffic) to clean-up the unexpected termination. 

 
A minimum of one user must be able to launch FastTrack Schedule to clean-up 
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unexpected terminations. If you cannot run the application (the Concurrent Users 
dialog appears), locate one of the users listed in the dialog and try Step 1 again 
from that user’s workstation. If you are still not successful in cleaning-up after the 
unexpected termination, try Step 3. 

 
3. If neither of the previous steps clean-up the unexpected termination, clean-up the 

termination by deleting the AppD2100.ApD file from the AppData folder next to 
the FastTrack Schedule application. 

 
 

 

Frequently asked questions 
Question: Why does FastTrack Schedule require that I enter the license key each 
time I start the application? 
 
Answer: You do not have read/write privileges for the AppData folder and its 
contents. See “Setting user access privileges” in Chapter 3, Additional Installation 
Activities, for more information. 
 
Question: Why do I get a Concurrent Users alert when I try to open FastTrack 
Schedule? 
 
Answer: If you are not exceeding the maximum number of licensed concurrent users, 
then, most likely, FastTrack Schedule was active when you had an unexpected 
termination. For example, FastTrack Schedule was open (either in the foreground or 
background) when the operating system crashed and you had to restart your 
computer. 
 
To solve the problem, follow the directions in the previous section, Restarting after 
unexpected termination. If you are running a network-installed version and the 
maximum number of concurrent users has not been reached, FastTrack Schedule will 
open the application using another one of the available concurrent-user licenses. 
 
Question: Why is the Concurrent User number that is currently displaying different 
from the number of licenses I purchased? 
 
Answer: Check to be sure that you entered the correct enabling license key. 
 
Question: Why do I get an alert message telling me that the maximum number of 
users is running FastTrack Schedule over the network when no one is running the 
application? 
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Answer: This can occur following a crash at any user’s workstation. The Network 
Administrator needs to delete the AppD2100.ApD file from the AppData folder next to 
the application located on the server. It will be regenerated when you run the 
application. 
 
Question: Once a minute, my computer gives off a default alert sound; why? 
 
Answer: The Network Administrator needs to give you read/write privileges to the 
AppData folder. The alert sound is triggered by your computer’s attempts, at 60-
second intervals, to open the AppData folder properly (read/write). When it is unable 
to do this, the alert is activated. See “Setting user access privileges” in Chapter 3, 
Additional Installation Activities, for more information. 



AEC Software     22611-113 Markey Ct.     Sterling, VA 20166 USA

Thank you for purchasing FastTrack Schedule. Your concurrent-user version of FastTrack Schedule has 

license key which controls the total number of concurrent licenses. You can add additional licenses at 

any time. To place an order for additional licenses, contact the AEC Software Sales Department at 

(800) 450-1985, (703) 450-1980, or send an email to sales@aecsoftware.com.

Upon purchasing additional licenses for concurrent users, you will receive a new purchase confirmation

email with a new license key. Simply replace your license key by entering your new license key in the 

Change License section of the About dialog, and FastTrack Schedule will automatically increase the 

number of concurrent licenses. Use the log below to monitor and track license key changes and the total 

number of current licenses. For detailed instructions on adding licenses, see Chapter 2 of this guide.

License Key:

Original No. of Licenses: To confirm the number of licenses, check the About dialog.

tel 703.450.1980     fax 703.450.9786     www.aecsoftware.com

License Key Total number of licenses Date purchased
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